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INTRODUCTION 

 

This manual does not discuss using the Burke-Gaffney Observatory generally or its Planewave 

Corrected Dall Kirkham (CDK) 24 inch (0.61-metre) telescope. Before using the CCD Camera, it 

is assumed that you have first read this document, then been checked out on the CCD camera by 

a staff member. It is also assumed that you have some familiarity with the principles of CCD 

imaging either from the course you are taking or from self-study.  

 

It attempts to explain what you should be doing before and during your observing session, but 

does not try to answer all possible questions regarding the use of the CCD camera. You are 

expected to solve the little problems as they arise. You should anticipate some problems at the 

telescope, especially if you are a new observer. Hopefully, these will be minor irritations. But do 

not be discouraged if your first session with the camera is less productive than you had hoped. 

 

CCD SPECIFICATIONS 

 

The model of CCD is Apogee Aspen CG16M. The sensor is a TrueSense KAF-16803. Technical 

specifications can be found at: http://www.andor.com/scientific-cameras/apogee-camera-

range/aspen-ccd-series.  

 

Some important specifications are below: 

 

Key Specifications (per pixel – adjust for binning used) 

System Noise 9 electrons RMS 

Digital Resolution 16 bits (1 part in 65536) 

Dark Current (at -25 degrees C) 0.2 electrons per second per pixel (1x1 

binning) 

Cooling Capacity >60 degrees C below ambient temperature 

(50 degrees C is a safer value to use)   

Linear Full Well 100K electrons 

Shutter Type 5 vane Iris type – 30mS actuation time plus 

10-40mS bounce settling 

 

KAF-16803 CCD Spectral Quantum Efficiency 
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The CCD is equipped with rotating filter assembly, model Apogee AFW50-10S. It contains 10 

50mm square optical filters as follows: 

 

Filter Name Model Description 
LUM (Luminance) Astrodon Luminance (Lum in 

graph below) 

Luminance (includes Red, Green and Blue band 

passes) 

RED Astrodon Red Red for pretty-pictures 

GRN (Green) Astrodon Green Green for pretty-pictures 

BLU (Blue) Astrodon Blue Blue for pretty-pictures 

B Astrodon B Photometric Johnson B 

V Astrodon V Photometric Johnson V 

R Astrodon R Photometric Cousins R 

I  Astrodon I Photometric Cousins I 

OIII Astrodon OIII Narrowband (3nm) OIII line (501nm) 

Ha Astrodon H-Alpha Narrowband (3nm) H-Alpha line (656nm) 

SII (not normally installed) Astrodon SII Narrowband (3nm) SII line (672nm) 

 

Details on these filters can be found at http://www.astrodon.com. 

 

 

OUTLINE OF THIS DOCUMENT 

 

Topics are presented roughly in the same order as you will need to follow: 

 

 EQUIPMENT SETUP — Section 1. 

 

 STARTING THE CAMERA —Section 2. 

 

 USING THE INSTRUMENT SELECTOR — Section 3 

 

 ORIENTATION OF THE IMAGE DISPLAY — Section 4 

 

 FOCUSSING —Section 5 

  

 TYPES OF ASTRONOMICAL IMAGES — see Section 6 



 4

 

 FLAT FIELD IMAGES — Section 7 

 

 EQUIPMENT SHUTDOWN — Section 8 

 

IMAGE CALIBRATION — Section 9 

 

WHAT TO DO IN ORDER TO GET IMAGES — Section 10 

 

 

1. EQUIPMENT SETUP 

 

Students will find the camera and all of its equipment ready to use. Provided you have the 

telescope setup for visual observing, you will only need to follow the instructions below to get 

started. 

 

The CCD Camera is connected Port 1 of an Optec 4-port instrument selector. In order for light to 

reach the camera Port 1 must be selected (see Section 3). On the back of the instrument selector 

is a white button. Press this button until the red LED next to the #1 is illuminated. This is the 

default port on power up. It can also be remotely-controlled from the Mission Control software 

– select the “Manual Operations” tab and press the “1: CCD” button in the Instrument Selector 

Control section. 

  

  
 

Also included is a Planewave IRF90 Focuser/Instrument Rotator. It 

provides electric fine focus and the ability to rotate all the equipment 

on the back of the telescope. When the telescope is in its usual park 

Instrument Selector 

CCD Camera 

Filter Wheel 

Focuser/Instrument 

Rotator 
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location, the CCD camera should be located to the right (its software knows this as the 180 

degree position). For normal imaging, it should not be moved from its default location. 

 

 

2. STARTING THE CAMERA 

  

a. CAMERA — When the telescope is powered on, the CCD Camera and its filter wheel are 

also powered on.  

 

b. THE COMPUTER — The right-side computer in the Warm Room controls the camera (and 

everything else). It is assumed that you have the observatory and telescope started up for visual 

observing, so are therefore already logged into the computer. 

 

c. DATA DIRECTORY — Create the directory for storing your night’s work. You can do this 

using the facilities of the “Computer” item in the Windows Start Menu. Store images in the 

Z:\images directory. This directory is stored downstairs on one of our Linux servers, and is “read 

only” accessible from your Linux account as “/home/bgo/images”. Make a directory pertaining to 

your name, group name, or project (if it doesn’t already exist), then make a sub-directory 

containing the current date for each night of observation. If you have trouble saving images to the 

“Z:” drive, as a temporary measure, store images in a folder on the Windows Desktop. 

 

d. CCD CONTROL PROGRAM – Startup the MaxIM DL camera software and connect to the 

CCD camera with the Mission Control (MC) software – select the “Manual Operations” tab and 

press the “Connect” button in the CCD Control section. Do not start Maxim DL manually and 

do not close it except by using the MC Software. 

 

In MaxIM DL, access camera functions with the Camera Control Window. If not already 

displayed, access it from the menu item View -> Camera Control Window. 

 

In the MC software, turn on the CCD’s Cooler by selecting a temperature in the “CCD 

Temperature” field and pressing the “Cooler On” button. The current cooler setpoint temperature 

is displayed in the “CCD Temperature” field. Decide whether to use the current setpoint 

temperature or enter a new one. Read about the setpoint temperatures in the box below. 

 

Turn on the CCD’s Cooler by pressing the “Cooler On” button in the MC Software. 
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Notes on the Setpoint Temperature 

  

The minimum setpoint temperature should generally not be colder than 45 

degrees C below the temperature in the Dome. Check the Dome temperature 

(it is displayed in the PWI software – click on the Temperature tab near the 

right side of the window – look for the Ambient reading). 

 

Our practice is that the setpoint temperature is AN INTEGRAL MULTIPLE 

OF 5 DEGREES C which is at least as warm as the minimum allowed 

temperature.  For example, if the minimum value is estimated to be –32 C 

enter the value –30 C for the setpoint temperature. If the minimum value is –

47 C, then enter –45 C.  For spring, summer, and fall, a good setpoint 

temperature is –30 C. For winter you can also use –30 C but a lower value 

such as –40 C will provide images with less thermal noise.  

 

The temperature should be allowed to stabilize before taking images you plan to keep, including 

calibration images. You can monitor the CCD temperature with the “Status” tab of the MC 

Software. Press the “Enable All” button to enable status updates for all the hardware including 

the CCD. It takes about 20 minutes for a 35 degree change in temperature (ambient air 

temperature to CCD setpoint). 
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Read about the setpoint temperatures in the box below. 

 

MaxIM DL Camera Control Window - Expose tab 

 

Set the CCD on-chip “Binning.”  A good default value is 3. The resolution of the images for 

three settings is given in the table below. Note that a binning setting of 1x1 results in pixels of 

too small an angle to be practical given the telescope’s focal length and atmospheric seeing.  

  

Binning Selection 

(FOV= 31.9’ x 31.9’ 

Physical Bin Size  

(microns) 

Image Resolution 

(arcseconds) 

Image Size 

(pixels) 

1 9 x 9 0.47” x 0.47” 4096 x 4096 

2 18 x 18 0.94” x 0.94” 2048 x 2048 

3 (suggested setting) 27 x 27 1.40” x 1.40” 1365 x 1365 

4 36 x 36 1.87” x 1.87” 1024 x 1024 

 

 
 

Press the Options arrow to make sure No Calibration is checked. This ensures that images are 

not pre-processed, but your images might not look as good initially as if you had chosen Simple 

Auto-dark. If you’re only interested in getting something nice-looking fast, and don’t intend to 

save the image, choose the latter. Simple Auto-dark takes a dark frame of the same exposure 

length immediately after your “sky” image. 

 

f. SET IMAGE PATH — Also in Options, select Set Image Save Path… to the folder you 

created in step c. 

 

g. TESTING THE SETUP — Try taking a few dark exposures after everything seems to be up 

and running. 
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In the Camera Control Window, choose the Expose tab.  Set Frame Type to Dark and 

Binning to 3.  Make sure the On check is off in the Subframe area. Enter an exposure time of, 

say, 60 seconds. Set the exposure type to Single. Press the Start button to begin the exposure.   

 

The image should be displayed automatically.  You should see a random smattering of bright 

pixels in an otherwise dark field (a sample 1 minute dark frame is shown below). 

 

 
 

IF  YOU  CANNOT  GET  A RECOGNIZABLE  DARK  IMAGE,  STOP  AND  FIND  OUT  

WHY. 

 

h. IMAGE DISPLAY — With a displayed image 

selected, choose Screen Stretch Window from the 

View menu. The CCD brightness levels have an 

integer range of 0 to 65535 (this is 16 binary bits or 

two to the power sixteen less one) – these values are 

known as ADUs (analog to digital units). This large 

dynamic range available, which may only contain 

useful intensity information in a narrow range of 

values, needs to be fit within the 8 bit (255 shades of 

grey) range that can be displayed properly on the computer’s monitor. 
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The graph shows a histogram with bins of ADU values on the horizontal axis and the relative 

abundance of values in each “bin” on the vertical axis.  

 

Move the coloured triangles to emphasize various brightness-levels in the data. There are also 

pre-set screen stretch settings (Low, Medium, High, etc.) that you may wish to try. Changing the 

screen stretch does now also the image data, just how it is displayed.  

 

3. USING THE INSTRUMENT SELECTOR 

 

The Instrument Selector is 

used to direct the light path 

of the telescope to one of 

four instrument locations. It 

uses a motor and a rotating 

mirror. Position 1 is the CCD 

Camera and is the default 

position at power up. The 

eyepiece focusers are at 

positions 2 and 4.  

 

Change the position using the 

white button on the back the 

unit. A red LED shows the 

present position selected.  

 

It can also be remotely-

controlled from the Mission 

Control software – select the 

“Manual Operations” tab and press the “1: CCD” button in the Instrument Selector Control 

section. 

 

If you are having trouble finding an object in the CCD Camera, you can use an eyepiece. Using 

the 41mm PanOptic eyepiece, the field diameter is similar to that of the CCD Camera. Note that 

the image in the eyepiece is a mirror-reversed view. Do not forget to change the Instrument 

Selector back to position 1 for CCD Camera usage. 

 

 

4. DISPLAY ORIENTATION 

 

The CCD camera is mounted on the telescope such that when: 

 

• the body of the telescope is on the east side of the mount (usually looking towards the 

west), north on the screen is up and east is to the left.  
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• the body of the telescope is on the west side of the mount (usually looking towards to 

east), south on the screen is up and west is to the left.  

 

This assumes the instrument rotator is not moved from the normal position (180 degrees). 

  

 

5. FOCUSSING THE CAMERA 

 

At the beginning of each observing session, the telescope needs to be focused. It should be 

focused again if you notice a change in star sharpness, especially if the air temperature has 

changed by more than a few degrees. Filters can be changed without significantly affecting the 

focus.  

 

The focusing process is entirely automated and takes a few minutes to complete. All it needs is 

the telescope pointed a starry field! 

 

Using the MC software, “Manual Operations” tab, press the “AutoFocus” button in the CCD 

Control section. After the process has completed, you should take an image and inspect some 

stars in the image. The Full-Width Half Max (FWHM) should be under 3 and hopefully closer to 

2 pixels. This can be measured with the Information Window accessed with the MaxIM DL 

menu item View -> Information Window. Select the Aperture mode and hover the mouse cursor 

over several stars. Be sure to avoid over exposed stars – those with a maximum pixel value of 

over 60,000. 

 

6. TYPES OF ASTRONOMICAL IMAGES 

 

The CCD can produce the following types of images (“Frame Type” in the Expose tab): 

 

LIGHT — an image which records the sum of the bias, the thermal charge, and photocharge 

(charge due to light falling on the CCD) during a preset integration time. This is your image of an 

astronomical object; 

 

BIAS — a image with the camera shutter closed having zero integration time. The output is a 

record of the “signal” which is produced by the electronics, essentially a “zero” point for each 

pixel in the image; 

 

DARK — an image with the camera shutter closed which records the sum of the bias and 

thermal charge accumulated by the CCD during a finite integration time; and 

 

FLAT – a “LIGHT” image of a uniformly illuminated source (see below). 

 

PHOTOMETRIC IMAGERY — If you plan to obtain quantitative intensity measures from the 

images, plan to acquire several bias, dark, and flat images, hopefully with dark integration times 

of around 5 to 10 minutes. These can be obtained during the day, but must be made with the same 
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set-point temperature and binning setting as the sky images. Several dark images are superior to 

one, because they can be averaged by MaxIm DL to produce a lower-noise mean dark image. 

 

When saving any images, be sure save as type “FITS Images” in format 16 or 32 bit or IEEE 

float, uncompressed, and with Auto Stretch disabled. FITS mean Flexible Image Transport 

System and is a standard image format designed for astronomical images that contains both the 

image data and comprehensive tabular meta data about the image (called the FITS header). 

 

 

7. FLAT FIELD IMAGES – a “Must” for the best results! 

 

ARTIFICIAL FLATS — Before accurate intensity information can be extracted from a CCD 

image it has to be corrected for the fact that different pixels in the chip have different light 

sensitivities. These different light sensitivities are due to a variety of factors including optical 

vignetting (uneven field illumination from the telescope optics), dust in the light path casting 

shadows on the CCD chip (these appear as “donuts”), and pixel-to-pixel variations of the CCD 

chip itself. These variations in sensitivity are also wavelength dependent so flat images have to 

be taken through each filter used. 

 

You can produce flat images (a sample is below) using our special-purpose flat field panel. The 

CCD must be at the same temperature, rotation, and focus position when taking flats as for the 

sky images. Therefore it is best to take flat field images on every observing night after you have 

focused the telescope or at the end of the night. Averaging together several flats for the same 

filter will reduce the noise in the final processed image. 

 

   
 

Use the following procedure to take Flat Field images: 

 

1. Move the telescope to be exactly in front of the panel – this is done in the MC 

software. In the “Manual Operations” tab, “Flat Panel Control” section, press the 

“Move Telescope to Flat Panel” button. 
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2. Set the desired panel brightness and press the “Panel On” button. 

 

 

3. Turn off the room lights in the dome and close the door. If done during the day, the 

dome must be closed. If done at night, it can be open (not preferred), but should be 

rotated towards the west to reduce extra light from the sky. If the moon is up, the 

dome should be closed. 

 

4. Expose at least 5 flats in each filter used. They should be exposed to produce 15,000 

to 40,000 ADU in the brightest pixels. In MaxIm DL, use the “View � Information 

Window” to inspect the images. Using 3x3 binning, the table below provides 

exposure times and flat field panel brightness settings should get you reasonably 

close. 

 

5. After you are done, turn off the panel with the “Panel Off” button. 

 

 

Filter Exposure Time (seconds) Panel Brightness 
LUM 15 30 

RED 15 40 

GRN 15 40 

BLU 15 40 

B 15 50 

V 15 30 

R 15 50 

I 15 30 

OIII 20 70 

HA 30 70 

SII (not normally installed) 30 70 

 

SKY FLATS — The twilight sky is also an excellent source for flat field exposures. This 

technique is a bit tricky, because the sky brightness changes rapidly. However, sky flats are 

generally regarded as (slightly) superior to flats taken with artificial light sources. 

 

8. EQUIPMENT SHUTDOWN 

 

After you are finished using the CCD Camera, it must be shutdown properly as follows: 

 

1. In the MC software in the “Manual Operations” tab, “CCD Control” section, set the 

temperature to 0 and press the “Cooler On” button (this actually just sets the temperature 

to be warmer).  

2. Allow it to warm up for at least 10 minutes. 

3. Press the “Cooler Off” button. 

4. Press the “Disconnect” button (CCD Control section). 

5. Complete the Shutdown section of the BGO Quick Instructions sheet.  
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9. IMAGE CALIBRATION 

 

Prior to using, processing, printing, etc. your CCD images, they need to be calibrated. The bias, 

dark, and flat images are used to do this. This involves several steps as follows: 

 

Prepare master images: 

 

a. the “bias” images are averaged to obtain a single master “bias” image 

b. the “dark” images are averaged, then the master “bias” image is subtracted to result in a master 

“dark” image. 

c. the “flat” images are averaged, then the master “bias” is subtracted, then the master “dark” 

image (scaled to match the exposure time of the flat image) is subtracted. 

 

Calibrate “sky” images: 

 

a. subtract the master “bias” image 

b. scale the master “dark” image to match the exposure length of the “sky” image 

c. subtract the scaled “dark” image 

d. divide by the “flat” image, then multiply by the average of all the pixels in the “flat” image 

e. presto! a scientifically-calibrated image has emerged! 

 

The above calibrations are to be performed by the IRAF software for ASTR 4200 students. 

Other courses and observers can use the calibration facilities of MaxIM DL – see below.  

 

From the Process menu, select Set Calibration (the dialog box below appears). 
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Remove any existing calibration files using the Remove Group button. Use Add Group to add a 

group for BIAS, DARK, and FLAT images. Use the Add button three times to add the 

calibration files for each type of file. When the dialog box pops up, you can select multiple files 

by holding down the “Ctrl” key and clicking on each file. In each case select “Sigma Clip” for 

the Combine Type setting. For the dark frames select “Auto-Scale” for the Dark Frame Scaling 

setting. “Flat Norm.” should be set to Monochrome. 

 

Press OK when done. Your master images are now ready! 

 

To calibrate each individual “sky” image, highlight it and then select the Calibrate item in the 

Process menu. To calibrate all images currently loaded use the Calibrate All selection. 

 

After the images are calibrated, be sure to save your images (see the File menu, Save As 

function). Do not overwrite your raw images. Give them new filenames. You can always 

reprocess your images if you make a mistake, but you can’t unprocess them to get back your raw 

images. Get in the habit of making copies of your raw images before processing them and 

working from the copies, rather than from the originals. 

 

 

10. WHAT TO DO IN ORDER TO GET IMAGES 
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a. Follow the Start Up section of the BGO Quick Instructions sheet. This is an obvious first 

step for all observers and gets you to the point of having the dome open, telescope and all 

instrumentation on and the telescope pointed at a bright star. 

 

b. Start up the CCD Camera and its MaxIm DL software — The first thing to do is to 

connect to the camera and begin cooling the CCD chip, get a couple of test dark frames, and 

create a directory on the “Z:\images” directory used to save that’s night’s images. Read Section 2. 

 

c. FOCUS THE TELESCOPE — A good focus often means a nice looking and high quality 

image. Poorly focused images not only look bad, but the quality of the data extracted from them 

will be of poor quality (eg. noisy). 

 

d. LOCATE THE TARGET — The pointing system should allow you to easily position to the 

telescope so that the target can be seen in the field eyepiece or on the CCD chip. If not, then point 

at a nearby bright star and use the Telrad finder to centre the star and sync the scope on it. The 

rectangular telescope target in ECU is set to the angular size of the CCD and the circular field 

closely matches the 41mm PanOptic eyepiece. 

 

e. USE THE INSTRUMENT SELECTOR — Remember to use the white button on the back 

of the instrument selector to direct light from the telescope to either the eyepiece or CCD camera 

as appropriate. 

 

f. CHECK THE CENTERING — Take a few short exposures of your target through the 

Luminance (LUM) filter. A 10 to 30 second long exposure will likely show your target nicely. 

 

g. SELECT THE EXPOSURE PARAMETERS FROM THE Expose tab — if you used the 

“Continuous” exposure mode for focusing, don’t forget to set it to “Single” when taking images 

of the sky. 

 

h. SAVE YOUR IMAGES — Save your images to the directory you created earlier on the “Z:” 

drive. Make sure you use FITS format and be sure that the “Auto Stretch” checkbox is off. 

 

i. TAKE BIAS, DARK, AND FLAT IMAGES — Don’t leave the observatory without taking 

bias, dark, and flat calibration images. 


